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Documentation information 
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Phone Manager:  

1. Phone Manager
This guide covers the installation, configuration and administration support for IP Office Phone Manager. Phone Manager
software is a single application that can be run in several modes:

· Phone Manager Lite
No license required.

· Phone Manager Pro
A Phone Manager Pro license key is required for each Phone Manager Pro user. If insufficient licenses are available,
Phone Manager operates in Lite mode.

· Agent Mode
This mode is a selectable option, available to users configured for Phone Manager Pro. In this mode, the
Phone Manager user has access to several call center agent related functions.

· Login Mode (Hot Desking)
This mode is a selectable option available to users configured for Phone Manager Pro. Starting or stopping
Phone Manager can be used to log the user on or off a physical extension. The extension is specified when
starting Phone Manager. When logged on, the Phone Manager user's own extension number overrides that of
the any user currently logged onto that extension.

· Telecommuter Mode (Phone Manager 4.1+)
In this mode, a user running Phone Manager Pro on a PC with a data connection to the IP Office (for example
via VPN), is able to have their calls routed to a telephone number they specify when starting Phone Manager.
When the user makes a call using Phone Manager, the IP Office will call the user's specified telephone number
and when answered, then make the outgoing call for the user. Similarly incoming calls to the user's extension
on the IP Office are routed to the remote number. By having the speech part of all calls initiated from the IP
Office, the cost for those calls is assigned to the IP Office.

· Phone Manager Pro PC Softphone
Each Phone Manager Pro PC Softphone (VoIP) mode user requires a 'Phone Manager Pro' and a 'Phone Manager
Pro IP Audio Enabled' license key. If insufficient licenses are available, Phone Manager operates in Lite mode.

 

The modes available are controlled by the Phone Manager licenses entered into the IP Office configuration. The mode for
each user is set through the IP Office Manager program.
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1.1 Installation Summary
The installation process is divided into the following steps. These should be performed in the order indicated.  

1. ¨ System-Wide Actions
The following steps should be completed before installing Phone Manager on any individual PC.

1.1.¨ Pre-Installation Requirements
Check that the pre-installation requirements for material required and PC specifications have been meet.

1.2.¨ Planning forms
Ensure the planning forms or a similar document has been completed.

1.3.¨ Entering License Keys
If any Phone Manager Pro and or Phone Manager PC Softphone users are being installed, the appropriate
licenses must be installed (along with the IP Office Feature Key dongle if necessary) and checked.

1.4.¨ User Configuration
Various aspects of Phone Manager operation including the mode in which Phone Manager runs are set through
the IP Office system configuration.

 

2. ¨ Individual PC Actions
Once the above steps have been completed, installation onto individual PC's can be commenced.

2.1.¨ Remove previous versions of the software
Versions of Phone Manager prior to Phone Manager 3.2 do not support upgrading. These versions must be
removed before proceeding with the installation of Phone Manager 3.2 or higher.

2.2.¨ Install the Phone Manager software
The process assumes that the user's PC is connected to the LAN and can see the IP Office. For more information,
see Installing Phone Manager Software .
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Phone Manager: Installation Summary

1.2 Pre-Installation Requirements
¨ Materials Required

· ¨ Phone Manager Software
The Phone Manager software is provided either on:

· ¨ The IP Office User Application CD.

· ¨ The IP Office Applications DVD.

· ¨ Alternately the software can be downloaded from http://support.avaya.com.

· ¨ AvayaFW.bat
This file is a batch file that adds various IP Office applications and the ports that they frequently use as exceptions to
the Windows in-built firewall settings. This file can be downloaded from http://marketingtools.avaya.com/tools/
firewall.

· ¨ Licenses
Phone Manager Lite does not require any licenses. Phone Manager Pro and Phone Manager PC Softphone require the
following licenses entered into the IP Office system configuration. The licenses must match the serial number of the
Feature Key dongle present in the IP Office system.

· ¨ Phone Manager Pro (per user)
Enables Phone Manager Pro for 1, 5, 10, 20, 50, 100 or unlimited users.  

· ¨ Phone Manager Pro IP Audio Enabled (per seat)
Enables Phone Manager Pro IP Softphone operation for a user. The user also requires a Phone Manager Pro license.

 

¨ Information Required
This information can be gathered by completing the Planning Forms included in this documentation. The following
minimum information is required.

· ¨ Details of the user names, extension numbers and the required Phone Manager types are required.

· ¨ Also PC locations and account name and password necessary for PC Administrator rights during installation.

· ¨ Service user name and password for IP Office system configuration access.
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¨ User PC Requirements 
There are the minimum recommended PC specifications for Phone Manager.

Phone
Manager
Mode

RAM HD Pentium Celeron AMD XP
Pro

Vista 2000
Pro

2000
Server

2003
Server

Lite/Pro 64MB 160MB 800MHz Celeron 3
800MHz

Althon B
650Mhz

PC
Softphone

128MB 1GB

· ¨ Language Support
Phone Manager supports the following languages. The language used can be selected by the user when running Phone
Manager.

· Brazilian, Chinese (Simplified), Danish, Dutch, English, Finnish, French, German, Italian, Korean, Latin Spanish,
Norwegian, Portuguese, Russian, Spanish and Swedish.

· Additional Requirements

· ¨ MS Internet Explorer 6.0 or higher.

· ¨ A sound card is needed if audio features are required.

· ¨ Phone Manager Pro PC Softphone also requires the user's PC to have a speaker and microphone installed. The
user must be associated with an IP extension on the IP Office.

· ¨ If installing Phone Manager Pro PC Softphone, it is recommended that QoS is setup. For more information, see
VoIP Quality of Service (QoS) .

· ¨ VoIP operation of Phone Manager is subject to the same requirements of VoIP network assessment as for any
other IP Hardphone installations.

· ¨ For remote PC VoIP operation, only VPN connections are supported. Non-VPN connections might work but are not
supported.

· ¨ Phone Manager is only supported on the primary screen of dual and multi-screen PC configurations.

 

26
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Phone Manager: Pre-Installation Requirements

1.3 Planning Forms
Completing the following details will assist in the installation of Phone Manager at a site.

· Site Name: ___________________________________

· Customer Contact Name: ________________________

· Contact Telephone Number: ______________________

 

· IP Office System:

· IP Address: ___:___:___:___

· Sub-Net Mask: ___:___:___:___

 

· Feature Key Dongle:
Required if any users are to use Phone Manager Pro or Phone Manager PC Softphone modes.

· ¨ Already installed / ¨ Being installed at same time.

· Dongle Type: ¨ Serial / ¨ Parallel / ¨ USB.

· Dongle Serial Number: ___________________________

· Feature Key Server PC:
(Required for parallel or USB port feature key dongle).

· IP Address: ___:___:___:___

· Sub-Net Mask: ___:___:___:___

 

· License Keys:
It is recommended that the Phone Manager license keys, if used, are obtained in the form of an electronic document
from which they can be cut and pasted. This reduces the chance of errors during license key entry.

License Name License Code Number of Seats
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Phone Manager Users

Real Name IP
Office
Name

Extension Number Password Location Phone Manager Type

Lite Pro VoIP

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨

     ¨ ¨ ¨
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Phone Manager: Planning Forms

1.4 Entering License Keys
This section assumes that the IP Office feature Key dongle has already been installed and setup plus the IP Office Feature
Key server software if required. If this is not the case, refer to the IP Office Installation manual.

To enter license keys in IP Office Manager:

1.Make sure that you have the list of licenses ready and that they match the serial number of the dongle being used
by the IP Office.

2.Preferably the licenses should be in an electronic document from which they can be cut and pasted into the
configuration. This reduces the chances of errors in the license entry.

3.Open IP Office Manager. Click  and receive the configuration from the IP Office system.

4.Click  License. Any existing licenses are listed.

5.Click Create a New Record in the Group Pane. Select License.

6.Enter the license key in the license key field. If the licenses are in an electronic format copy the license and paste
in the license key field.  

7.Click OK. The Status of the newly entered license is Unknown.

8.Repeat the above steps for any additional licenses.

9.Click  and send the configuration back to the IP Office. If the only changes made were to add license keys, this
can be done using merge.

10.Click  and receive the configuration from the IP Office system again.

11.Click  License.

12.Verify that the Status of the license entered has changed to Valid. If a license is listed as Invalid, ensure that it
was entered correctly.

 

Checking Licenses using Phone Manager 
The number of licenses available and the number still free can be checked through any running copy of Phone Manager.

1.Select Help > About Phone Manager.

2.Hold down the Ctrl and Shift keys. A list of licenses is shown.
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1.5 Changing IP Office Manager
Within the IP Office configuration, a number of user settings for Phone Manager are located on the User | Phone
Manager Options tab. These settings can be applied in a number of ways.

· They can be applied to the user the first time they start Phone Manager on a PC but then changed by the user.

· They can be applied to the user every time they start Phone Manager.  

· They can be set as part of a set of User Rights which are then associated with the users to which they should be
applied. This method allows the same settings to be applied to a large number of users and then be altered as required
through the User Rights rather than having to alter each individual user.  

 

Important

1.The key setting that must be completed is the Phone Manager Type. By default this is set to Lite for Phone Manager
Lite operation.

2.User's intended for Phone Manager PC Softphone must be associated with a non-physical VoIP extension within the IP
Office configuration, that is not with a physical VoIP phone extension.

 

IP Office Manager Configuration Settings

1.Open IP Office Manager. Click  and receive the configuration from the IP Office system.

2.Click  and click the user's extension number in the Navigation Pane.

3.Select the Phone Manager Options tab. Those options marked with a  icon can also be set as part of the User
Rights.

· Allow user to modify Phone Manager settings: Default = On 
This setting is used with the Phone Manager Status Options, Screen Pop Options and Hide Options below.
It controls whether those options are applied every time the user starts Phone Manager or only the first time the
user starts Phone Manager.

· If this setting is enabled, then the IP Office configuration setting of those options are only applied the first
time a user starts Phone Manager on a PC. Those settings become part of the user's Phone Manager profile
on that PC. They can be changed by the user through Phone Manager. On subsequent Phone Manager starts
the Manager settings are ignored.  

· If this setting is not enabled, the IP Office configuration settings are applied every time the user starts
Phone Manager and cannot be overridden by the user.

· Agent Mode: Default = Off 
This option controls the setting of the Agent Mode option on the Configure Preferences | Agent Mode tab
within Phone Manager Pro. When enabled, the user has additional toolbar controls for Busy Wrap Up, Busy
Not Available and Select Group. Note that the options on the Phone Manager Pro Agent Mode tab can be
greyed out from user changes by the Agent Mode setting in Configuration Options below.  

· Phone Manager Type: Default = Lite 
Determines the mode in which the user's copy of the Phone Manager application operates. Modes are Lite, Pro
and Phone Manager PC Softphone. Note that the number of users able to simultaneously use Pro and VoIP
modes is controlled by licenses entered into the IP Office configuration. This setting cannot be changed by the
user. * For pre-3.2 IP Office systems this setting is located on the User | User tab.

· VoIP Mode: Default = On 
This option only appears if the selected Phone Manager Type is Phone Manager PC Softphone. It sets
the Enable VoIP control within the user's Phone Manager PC Softphone.

· Book a Conference in Phone Manager: Default = Off
When enabled, displays links in the user's Phone Manager application for access to the IP Office Conferencing
Center application if installed. Note that to book a conference requires the user to have a Conferencing Center
user ID and password. This feature also requires the Conference Center URL to be set (System | System).
This setting cannot be changed by the user. * For pre-3.2 IP Office systems this setting is located on the User |
User tab.

· Configuration Options 
These options allow the user access to the indicated configure preferences tabs within Phone Manager.

· The controllable tabs for Phone Manager Lite are Telephone and Do Not Disturb.

· The additional controllable tabs for Phone Manager Pro and Phone Manager PC Softphone are Screen Pop,
Compact Mode, Agent Mode, Voicemail (Voicemail and Voicemail Ringback controls only) and in IP
Office 4.0 and higher Mobile Twinning.
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Phone Manager: Changing IP Office Manager 

· Screen Pop Options 
These options allow selection of the Phone Manager Pro/Phone Manager PC Softphone screen pop options 
Ringing, Answering, Internal, External and Outlook.

· The Allow user to modify Phone Manager settings option controls whether these settings are applied
only when Phone Manager is first started or every time Phone Manager is started.

· Phone Manager Status Options 
These options allow selection of the tabs to show within the call history area of the user's Phone Manager.  

· The tabs selectable for Phone Manager are All, Missed, Status and Messages.

· The additional tabs selectable for Phone Manager Pro and PC Softphone are Incoming, Outgoing and
Account Codes.

· The Allow user to modify Phone Manager settings option controls whether these settings are applied
only when Phone Manager is first started or every time Phone Manager is started.

· Hide Options 
These options allow selection of the Phone Manager Pro/Phone Manager PC Softphone options Hide on close
and Hide on no calls.

· The Allow user to modify Phone Manager settings option controls whether these settings are applied
only when Phone Manager is first started or every time Phone Manager is started.

4.Select the Telephony tab. Check the following options:

· Call Waiting On.
When Call Waiting is on there is an audible tone when you are on a call and another call arrives. Phone Manager
allows the user to see the details of both calls and to switch between calls and is therefore a useful feature for
users with analog extensions. This option is ignored for users logged on to phones with multiple call appearances.  

· Busy On Held
When a call is placed on hold, it might be inconvenient to receive any further calls. For analog extension users it is
recommended that Busy on Held is switched on. A busy tone is heard by further callers until the held caller is
cleared. This option is ignored for users logged on to phones with multiple call appearances.

· Offhook Station.
Off Hook operation allows actions in Phone Manager, such as answer or make a call to be mirrored by the handset
hook switch of the users telephone. Depending on the phones hands free capabilities this allows the user to
answer, end and make calls using Phone Manager. This is not supported for analog extensions.

5.Click OK.

6.Repeat for any other users.

7.If all IP Office configuration changes are complete, click  and send the configuration back to the IP Office.
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1.6 Installing Phone Manager Software
This process assumes that the user's PC is connected to the LAN and able to see the IP Office.

To install Phone Manager:

1.Ensure that you have:

· IP Office user name and password.

· Phone Manager software or path to Phone Manager software on the network.

· AvayaFW.bat file or path to that file on the network.

2.Log on using an account with administrator rights for the PC, that is sufficient rights to install applications.

3.Check whether Phone Manager is already installed or not. If already installed:

· If the version is pre-Phone Manager version 3.2, it must be removed before proceeding any further. See Removing
Old Phone Manager Software .

· If the version is Phone Manager 3.2 or higher, it can be upgraded. See Upgrade Procedure .

4.Inserts the media containing the Phone Manager Software or browse to the network location where the software has
been placed.

· If installing from the IP Office User Applications CD, the CD should auto-start. If not open the CD and double click
on setup.exe.

5.The Setup Language window appears.

25

25
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Phone Manager: Installing Phone Manager Software

6.Select the language for the installation and click Next. The Preparing Setup screen appears for a moment.

7.The Welcome to the InstallShield Wizard for IP Office User Suite window appears.

8.Click Next.
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9.The Customer Information window appears.

10.Type the user and customer name.

11.Select Anyone who uses the computer and click Next.

12.The Choose Destination Location window appears.

13.Leave the directory setting at default unless absolutely necessary. Click Next.
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Phone Manager: Installing Phone Manager Software

14.The Setup Type window opens.

15.Select either Compact or Typical.

· Compact installs just Phone Manager and the language files that best match the PC.

· Typical installs Phone Manager and all supported languages plus the IP Office TAPI software.

16.Click Next.

17.The Start Copying Files window opens. To review or change any settings, click Back.

  

18.To begin copying the files, click Next.
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19.The Setup Status window appears. The files may take a few minutes to install.

20.When copy if files is complete the InstallShield Wizard Complete window appears.

21.If TAPI was installed, the PC may request a restart. Do not agree to this at this stage.

22.Click Finish.

23.Run the file AvayaFW.bat. This adds the IP Office applications on the user's PC as exceptions to the Windows default
firewall. Do this even if the user is not using the Windows default firewall. If the users has different firewall software
installed on their PC then different actions may be required to ensure the necessary exceptions are added to that
firewall software. See Phone Manager Ports and Firewalls .  

24.Restart the PC and log on with the intended users account.

25.Phone Manager should automatically start. Enter the users name and password as set on the IP Office system. If the
user is the only user of the PC, enable the Remember password option.

24
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Phone Manager: Installing Phone Manager Software

26.Once Phone Manager has started, check that Phone Manager is running in the Lite or Pro mode as required. If so, the
main installation process has been completed.

· For Phone Manager PC Softphone user an number of additional configuration steps need to be completed. See 
Configuring a PC Softphone .

 

22
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1.7 Configuring a PC Softphone

The presence of the  and  icons indicate that Phone Manager is running in VoIP mode. The title bar should also
state Phone Manager iPro or Phone Manager SoftPhone.  

Requirements and Notes

Phone Manager software checks for all the following when started. If not enabled, the application will not start in Phone
Manager PC Softphone mode.

· There must be valid Phone Manager Pro and Phone Manager Pro IP Audio Enabled licenses available when
the user starts Phone Manager.

· The user must be associated with an non-physical VoIP extension in the IP Office configuration. That is not with
a physical VoIP extension.

· The user's Phone Manager Type in the IP Office configuration (User | Phone Manager Options) must be set
to Phone Manager PC Softphone and the option PC Softphone mode should be enabled.

· The PC must be enabled for audio playback and recording via an installed soundcard or USB microphone
headset.

· Phone Manager PC Softphone always uses the default device specified under the Multimedia tab in the
Windows control panel.

· Ensure that Use only preferred devices tick box is enabled in the Audio tab of the Sounds and Audio
Devices option in the Windows control panel.

 

To make the changes in Phone Manager:

1.Click  > Phone Manager. Alternatively, click View > Preferences > Phone Manager. The Phone Manager
window opens.

2.Check Play Sounds and Enable VoIP.

3.To save your changes, click OK.

4.Click  | Audio Codec or click View | Preferences | Audio Codec. The Audio Codec window opens. Only make
changes here if they are matched by changes to the Extension | VoIP settings in the IP Office configuration.
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Phone Manager: Configuring a PC Softphone

5.Use the up and down arrows to select and adjust the list of preferred audio codec for VoIP communication.

6.If you are using a low bandwidth connection for example a dial Up Modem, increasing the Frames per packet to 2
might improve the quality of the VoIP communication. However, this is not guaranteed. If you are not using a low
bandwidth connection, it is recommended you use the default value of 1.

7.If you have multiple IP connections, select Confirm VoIP IP Address for the user to be prompted to select the IP
address for VoIP communication.

8.Enable FastStart should only be changed to match the setting as in the user's extension VoIP settings in the IP Office
configuration.  Select Enable FastStart to provide the caller with a ring tone. If it is not checked, the caller does not
hear a ring tone but the call is connected faster.

9.To save the changes, click OK.

10.Close Phone Manager. When you next start Phone Manager, the options selected will be active.

 

Note

· QoS support from the users PC is optional but is highly recommended. Windows 2000 and Windows XP are able to
provide the user with QoS that can be configure to match the QoS settings of the IP Office. See VoIP Quality of
Service (QoS) .  

 

26
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1.8 Phone Manager Ports and Firewalls
Phone Manager uses the following IP ports for communication with the IP Office.  If a firewall is placed between the user
PC and the IP Office, traffic on these ports should be allowed.

· Port 69 on the IP Office and the Phone Manager PC- TFTP
This is used by the Phone Manager to obtain data from the IP Office such as user name lists and the switch
directory. TFTP is also used during the application log on.

· Port 50796 on the IP Office - IPO PC Partner
This port is used by Phone Manager and Soft Console applications to establish communication with the IP Office for
call signalling, configuration changes, etc.

· Port 50799 on the Phone Manager PC - IPO BLF Updates
Used by Phone Manager to receive status updates for internal speed dial icons. These are sent from the IP Office
using the 255.255.255.255 broadcast address.

· VoIP
Phone Manager Pro PC Softphone uses ports 1719 and 1720 for H323 Gatekeeper discover and then a range of
ports for VoIP. Therefore, we can only recommend Phone Manager Pro PC Softphone operation across a firewall
when using VPN to tunnel the connection.

 

Using AvayaFW.bat

This file is a batch file that adds various IP Office applications and the ports that they frequently use as exceptions to the
Windows in-built firewall settings. This file can be downloaded from http://marketingtools.avaya.com/tools/
firewall.
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Phone Manager: Phone Manager Ports and Firewalls

1.9 Removing Old Phone Manager Software
If there is a version of Phone Manager below 3.2 already installed, the application must be removed before installation. If
the Phone Manager version is 3.2 or higher you can upgrade the software. For more information, see Upgrade Procedure

.

·  WARNING
This process will remove all installed components of the IP Office User Suite. If any of the following IP Office
applications are installed, ensure that they are reinstalled from the new IP Office User Suite:

· TAPI

· DevLink

· MS-CRM

· SoftConsole

 

To remove existing Phone Manager software:

1.Select Start > Settings > Control Panel.

2.Select Add/Remove Programs.

3.From the list of Currently installed programs, select IP Office User Suite.

4.Click Change/Remove. The InstallShield Wizard for the software suite is started.

5.When the option screen opens, select Remove.

6.When the option screen opens, select Remove.

7.You are asked 'Do you want to completely remove the selected application and all of its features?'. Click Yes.

8.Once the suite has been removed, click Finish and close Add/Remove Programs.

9.The Phone Manager software can now be installed. For more information, see Installing Phone Manager Software
.

 

1.10 Upgrade Procedure
If the application software is 3.2 or higher you can upgrade the software. You do not have to remove the existing version
of the software. 

To upgrade your applications:

1.Insert the IP Office User Suite CD. The CD will auto-start the InstallShield Wizard. The 'Welcome to the
InstallShield Wizard for IP Office User Suite' window opens.

2.Click Next. The 'Upgrade Features' window opens. A list of features that can be upgraded is listed.

3.Select the options you want to upgrade and de-select the options you do not want to upgrade.

4.To upgrade, click Next. The 'Setup Status' window opens. The selected features are upgraded, which may take
several minutes.

5.The 'Update Complete' window opens. To exit the InstallShield Wizard, click Finish.
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1.11 VoIP Quality of Service (QoS)
Phone Manager PC Softphone can support DiffServ QoS when running on Windows 2000 and Windows XP. However, it
requires QoS to be enabled within Windows. It is still dependent of QoS being supported at all switch/routing points
between the user and the IP Office. 

· The default DSCP (DiffServ Control Point) value used by Windows is 40 unless overridden. This differs from the
IP Office system default of 46.

 

Windows XP

The network card/interface being used must support 802.1p and the Windows QoS Scheduler must be installed. The
DSCP value might need to be changed.

To change the DSCP value:

1. Select Start > Run and enter gpedit.msc.

2. Open Local Computer Policy > Computer Configuration > Administrative Templates > Network > QoS
Packet Scheduler.

3. For the Guaranteed Service Type, enter the required DSCP value.

 

Windows 2000

· The network card/interface being used must support 802.1p.

· The following DWORD registry key must be added and set to 0 to enable DSCP marking.
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Tcpip\Parameters\DisableUserTosSetting

· To change the DSCP value to match that being used by the IP Office network, add the following DWORD registry
key set to the required value.
HKEY_CURRENT_USER\Software\Avaya\IP400\PhoneManager\DSCP
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Phone Manager: VoIP Quality of Service (QoS)

1.12 Telecommuter Mode
As normal, Phone Manager is used for call control and information over a data connection to the IP Office, with the
speech part of those calls being carried on a separate parallel voice call connection. IP Office 4.1 and Phone Manager 4.1
+ support Telecommuter mode, which allows the speech connection to be a remote phone location not on the IP Office.
Use of this mode is can be assigned to users in the IP Office 4.1+ configuration by the System Administrator.

When users of this mode start Phone Manager, they are asked for their location, this is either Internal or Remote.

· Internal is used when they are at their normal IP Office extension. In this state the extension and Phone Manager
operate in the same way as for other internal Phone Manager users.  

· Remote is used for they are at an external location from which they have a data connection for Phone Manager to
the IP Office and a phone on which they can make and receive direct calls. They can specify the remote location
number when logging in or use a previously saved location number. The remote phone number used must be one
that can be dialed directly from the IP Office, for example not via any switch board, receptionist or auto attendant
service. The user's normal IP Office call restrictions, if any, are applied and any external dialing prefix must be
included if used on the IP Office.

 

Configuring a User as a Phone Manager Pro Telecommuter

· Telecommuter is an option for Phone Manager Pro users and requires an available Phone Manager Pro license in
the IP Office configuration.

· Setting a user as a telecommuter is done through the User | Phone Manager Options | Phone Manager Type
field in IP Office Manager (or User Rights | Phone Manager | Phone Manager Type if the user is associated
with a set of user rights). Select Pro Telecommuter to allow use of telecommuter mode.

· Provision of a data connection from the user's Phone Manager Pro PC to the IP Office when remote from the IP
Office network is outside the scope of this documentation. The methods will depend on the customer network and
methods of Internet connection available. The use of VPN is recommended to ensure secure connection between
the remote site and the customer network.
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Continuous Mode

A key consideration for telecommuter operation is the trunk types involved. During Phone Manager login as a remote
telecommuter, the user is able to select whether for that location they should select Continuous Mode or not.
Continuous Mode changes the behaviour of Phone Manager and must be used when trunks without reliable disconnect are
in use or suspected to be in use between the IP Office and the user location.  

· Off
If Continuous Mode is not selected, the IP Office will only call the remote location number when required, that is
when making or receiving an IP Office call. For example when making a call using Phone Manager, the IP Office
will call the remote location, when answered it will make another call using the number requested in Phone
Manager. You can end the call through either Phone Manager or by replacing the handset.

· In this mode, it is possible for the remote location phone to make and receive non-IP Office calls. IP Office
calls can be distinguished by their indication in the Phone Manager call details display.

· Calls will not succeed if the IP Office detects that a trunk using analog loop start or analog loop start
emulation is being used.

· Pages calls are not redirected. Intercom and dial direct calls are redirected as normal calls.

· On
If Continuous Mode is selected, once you complete the Phone Manager login, the IP Office will call the remote
location number and when answered the user should leave the connection open (off-hook). This will occur as part
of either the test call if requested or after you click OK. Phone Manager is then used exclusively to make and
answer calls, with the IP Office connecting the speech path to the remote location phone handset as and when
required.  

· This option should be used whenever analog loop start trunks or analog loop start emulation trunks are in use
or suspected to be in use. This may include cellular phones connected to cellular gateways on analog trunks.

· If the IP Office has a mix of trunks, it may be advisable using outgoing group ID's, short codes and ARS forms
to configure a specific dialing prefix that ensure that their call are routed via trunks that provide reliable
disconnect and so remove the need for Off Hook Station operation.  
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Configuration

Chapter 2.
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2. Configuration
· Phone Manager indicates it is connected to the switch by showing the user name inside a pair of square brackets

'[ ]'. If the title bar displays 'Phone Manager' it is not connected to the switch.

· Only one instance of Phone Manager can be run at a time. When starting Phone Manager, if an existing instance of
Phone Manager is detected, the additional Phone Manager will exit silently.

· Phone Manager checks with the switch once every minute for the availability of the voicemail server. The record
and message panes are enabled or disabled accordingly. If the messages pane is unavailable, check the status of
the voicemail server.

· Do not connect 2 or more Phone Managers to the switch using the same user name, especially when Phone
Manager is operating in VoIP mode. This will lead to unpredictable or incorrect operation of Phone Manager.

 

2.1 User Settings and Profiles
For Phone Manager 3.0 onwards, all user settings are stored in a single local profile file. The exception is local directory
numbers. The profile file name matches the user's extension number, for example 212.xml. By default, the files are
stored in My Documents\Avaya\IP 400\PhoneManager\Profiles.

This file is created when a user with that extension number first uses Phone Manager. The file is not deleted by removal
of the Phone Manager application and a separate file is created for each extension number using Phone Manager on that
PC and that particular PC log on.    

Within Phone Manager, the File > Save Profile option can be used to save a copy of the profile to a different location.
You can load a profile from a different location using the option File > Load Profile. When loading a profile, the file
name must match the user's extension number.

2.2 Directory Entries
User directory entries entered through Phone Manager are saved to the file PhoneManagerDirectory.txt. This file is
stored in My Document\Avaya\IP Office\PhoneManager.  The file is a CSV file in the format:

· Name - The name to display in the directory.

· Number - The telephone number.

· wavfile - The path to the wav file to associate with the directory entry.

· scriptfile - The path to the script file to associate with the directory entry. This file can be a plain text file or an
RTF format file.

You can use Phone Manager to edit the contents and to import or export directory files. A large directory can degrade the
performance of Phone Manager as excessive CLI lookups and other actions have to be performed whenever a call arrives
or is made. The recommended maximum number of directory entries is 1000.

To configure the directory in Phone Manager:

1.Click File > Directory.

2.Make the changes as required.

3.To save the changes, click Close.
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Configuration: Directory Entries

2.3 Citrix/Thin Client Phone Manager
Phone Manager has been tested with Citrix. It is supported in Phone Manager Lite and Phone Manager Pro modes but not
in Phone Manager Pro PC Softphone (VoIP) mode.

Features Supported

· Phone Manager Lite and Phone Manager Pro.

· Screen popping to Outlook, Goldmine and Maximizer (not ACT!).

· Call recording and mailbox access to VoiceMail Pro.

 

Features Not Supported

· Phone Manager Pro Softphone (VoIP) mode. 
This is because of the inability to allow upstream audio on a Citrix server with Client Audio Mapping.

· Play Sound functions.
Some support is possible if the -nosoundcheck  command line option is used and client computer has an audio
card correctly mapped. However, some delay in the playing of sound might be experienced.

· The 'Hide on Close' option should not be used.

 

Notes

· The default skin of Phone Manager can cause issues for some thin client installations. You can run Phone Manager
without a skin by creating a empty text file called skin.ini.

· A maximum of 5 Phone Manager clients are supported using Citrix.

· No other IP Office applications have been tested on Citrix.
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2.4 Play Sounds Option
The Play Sounds option within Phone Manager plays various sound through the user's PC multimedia setup to announce
calls ringing and waiting. This option is available for all Phone Manager types.

The following wav files are used for the Play Sounds option. They are located in the Phone Manager application folder C:
\Program Files\Avaya\IP Office\Phone Manager. The wav files can be replaced with custom recordings as long as
they are in 16 bit mono wav file format. 

· NewCall.wav: Ringing.
Separate files NewCall_Eng.wav and NewCall_enu.wav can be used to replace the file with either UK or US ring
tone respectively.

· NewCallWaiting.wav: Ringing.

· NewMessage.wav: “You have a new message” supplied in appropriate language variants.

· Ding.wav: Ding.

 

To turn on the Play Sounds option:

1.Click  > Phone Manager. Alternatively, click View > Preferences > Phone Manager.

2.Check Play Sounds. Incoming calls are alerted by an incoming sound.

3.To save your changes, click OK.
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Configuration: Play Sounds Option

2.5 Configuring Instant Messaging
The Instant Messaging function of Phone Manager was developed and tested against Microsoft's Live Communication
Server (LCS) 2003. It has also been run using LCS 2005.

The LCS server requires both a Microsoft LCS server license and a LCS client license for each user. In addition, it requires
each Phone Manager user to also have Windows Messenger installed and running. You can Instant Message a user
through the Speed Dial icons in the Speed Dial Call History Pane. 

Requirements

1.LCS server PC requires:

· Microsoft LCS 2003 or 2005 with LCS Server license.

· Microsoft LCS Client license for each user.

2.IP Office Configuration requires:

· The users SIP URI used for instant messaging should be entered as their Voicemail Email address in IP
Office Manager. For example j.smith@acme.com would be entered as a voicemail email address in IP Office
Manager.

3.User PC requires:

· Windows Messenger.
This must be running and logged in at the same time as Phone Manager.

· Phone Manager.

 

Once these requirements are met, Phone Manager can be configured to support interaction with the Live Communication
Server.

To activate IM in Phone Manager:

1.Open Phone Manager.

2.Click  | Instant Messaging. or View | Preferences | Instant Messaging.

3.To turn instant messaging on, check Enable Instant Messaging Support.

4.In the Server field, enter the name of the Microsoft Live Communication Server.

5.In the user name field, enter your email account and domain as configured on the Microsoft Live Communication
Server. For example; myname@example.com.

6.In the Protocol field, click the type of protocol you are using to connect to the Microsoft Live Communication
Server. You can choose from TCP, UDP and TLS.

7.In the Password field, enter the password associated with your Instant Message profile.

8.For Phone Manager to remember your password, check Password. You do not have to re-enter your password if
this box is checked.

9.To save your changes, click OK.
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To configure an audible alert

Phone Manager does not give any audible alert when an instant message is received. However alerts can be configured
through the Windows Control Panel.

1. Click Start > Settings > Control Panel.

2. Select Sounds and Multimedia or Sounds and Audio.

3. Select the Sounds tab.

4. Scroll down the list of Program Events until the events for Windows Messenger are shown.

5. Configure the events as required and click OK.
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Configuration: Configuring Instant Messaging

2.6 VoIP Notes
· If the audio codec is changed in Phone Manager, the application must be restarted for the change to take effect.

· If the main window does not appear after a long time, this may be because Phone Manager is trying to
communicate with the VoIP server and the server is not responding. Use the Windows Task Manager to terminate
the process 'iClaritySrv.exe' and 'phonemanager.exe' and restart the Phone Manager.

· Windows 2000.
If Phone Manager PC Softphone operation appears to be degraded when the user performs operations such as
scrolling through a large document, the priority given by the PC to the iClaritySrv.exe task should be increased.

· Open the Windows Task Manager and select the Processes tab.

· Locate the iClaritySrc.exe process.

· Right-click on it and select Set Priority.

· Increase the priority as required.   

· Phone Manager checks for the presence of a sound card and if none is installed, the speaker and the microphone
icons are disabled. To use VoIP, the microphone must be selected as the recording device and not muted. On
some soundcards this is not the default and must be set manually.

· The speaker and microphone mute feature is only available if the sound card supports it.

· Enable faststart and Use direct media should be set for the VoIP extension.

· Offhook station should be set for the user associated with this VoIP extension.

· Phone Manager does not allow the user to specify which audio device to use for VoIP Phone Manager. It always
uses the default device specified under the multimedia tab in the control panel.

· When using the VoIP feature make sure the Use only preferred devices tick box in the Audio tab is selected.
The Audio tab is in the Sounds and Audio Devices option in the control panel.
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2.7 BLF Operation
This section describes the operation of BLF updates sent out by IP Office systems. There are several, separate
mechanisms for delivering BLF updates.

1.IP Office to IP Office
IP Office systems configured with SCN (Small Community Networking) enabled, exchange user state information
using SCN messaging. Each IP Office then provides that information as BLF updates to the phones and application
registered with it using the methods described below.

2.IP Office to Phones
IP Office hard-phones exchange user state information with the IP Office on which they are registered. IP phones
do this using the phone signalling messages embedded in the H.225 stream.

3.Local IP Office User Applications
Each IP Office system broadcasts BLF updates on its own subnet (or subnets if both LAN1 and LAN2 are
supported). Those messages are used by Phone Manager and SoftConsole registered with that IP Office and
running on the same subnet.

4.Remote IP Office User Applications
When a Phone Manager on a different subnet registers with an IP Office system, that IP Office will send BLF
updates directly to the PC as a Unicast message. Each IP Office only supports up to 10 such remote Phone
Manager applications, provided on a first come first served basis. That is, upon start-up only the first 10 Phone
Manager connections from a different subnet will receive BLF updates. Subsequent remote connections will operate
as normal except they will not receive BLF updates.

The diagram below shows an example scenario.

In this scenario:

1.User Alice at Site A goes off-hook. Alice's phone updates the IP Office at Site A.

2.Across the Small Community Network connection, Site A shares the information about Alice's current state with the
IP Office at Site B.

3.Bob and Carol are both users on Site B, with phones and running Phone Manager. Bob is on the same subnet as
the Site B IP Office, however Carol is on a different subnet from the Site B IP Office.

4.Bob and Carol's phones are both updated through their phone signalling with the IP Office at Site B.

5.Bob's Phone Manager sees and uses the BLF update that the IP Office at Site B broadcasts to its own subnet.

6.As Carol's Phone Manager is one of the first 10 remote Phone Manager's to register with the IP Office, the IP Office
at Site B sends a direct BLF update to it. 
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Configuration: BLF Operation

2.8 Conference Resources
A conference can be created using Conferencing Center, Phone Manager or SoftConsole. Each time a conference is
created resources are used. All the applications share the same conference resources.

System features such as call intrusion, call recording and silent monitoring all use conference resources. This includes
automatic recording, if enabled. When any of these features are active, the number of slots available for conference
parties is reduced.

The number of internal users and external callers that can be involved in conferences at the same time is limited by the
conference capacity of your IP Office telephone system.

IP Office Maximum Callers
in Any One
Conference

Maximum Total
Number of People on

Conference Calls

Maximum Number of
Conferences on the

System

Small Office Edition 6 24 8

IP403 64 64 21

IP406 64 64 21

IP412 64 128 42

IP500 64 64 21

· If IP Office Conferencing Center is installed, 5 resources are reserved for use by the system, for example; call
recording. The maximum number of callers in any one conference and the total number of people on conference
calls is reduced by 5. The maximum number of conferences on the system for IP403, IP406 and IP412 is reduced
by 2.

 

Examples

1.IP403 and IP406 support multiple conferences adding up to 64 callers in conferences.

· 21 x 3 way conferences.

· 1 x 10 way conference plus 11 x 3 way conferences. Free capacity for 20 more conference callers to join new
or existing conferences.

2.IP412 supports multiple conferences totaling up to 128 callers in conference with no more than 64 callers in any
one conference.

· The IP412 supports two 63 party conference banks. When a new conference is started, the bank with the
most free capacity is used for that conference. However, once a conference is started on one conference
bank, that conference cannot use any free capacity from the other conference bank.
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2.9 Command Line Options
2.9.1 Disabling Buttons

You can disable the conference calls  and transfer call  buttons, to minimize the risk of accidental conference or
transfer. This may be required in sensitive environments where conflicting parties may be held at the same time. The
functions are still available in the Functions menu.

To disable buttons:

1.Right-click on the Phone Manager shortcut and select Properties.

2.Select the Shortcut tab.

3.The Target will be similar to: "C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe" 

4.After the closing quotation mark, add -disable:ConferenceButton and/or -disable:TransferButton as

required. For example: "C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe" -disable:

ConferenceButton -disable:TransferButton 

5.Click OK.

6.Test the shortcut.

 

2.9.2 Logging in as a Specific User
In situations where users share a PC without logging on or off to Windows, it may be more convenient to have several
shortcuts to Phone Manager. Each shortcut can be configured for a different user. This can be done by adding the user
name and password to the separate Phone Manager shortcuts rather than changing it each time through File> Login. 

To create a shortcut:

1.Right-click on the Phone Manager shortcut and select Properties.

2.Select the Shortcut tab.

3.The Target will be similar to: "C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe".

4.After the closing quotation mark, add the IP Office IP Address, the User Name in quotation marks and the user
password in quotation marks. If the password is blank, add "". For example: "C:\Program Files\Avaya\IP
Office\Phone Manager\PhoneManager.exe" 192.168.42.1 Extn201 "" 

5.Click OK.

6.Test the shortcut.

 

2.9.3 No Sound Check
There are some installations where, even though no Phone Manager sound features are being used, a "Mixer Not
Detected" error appears each time Phone Manager is started. This can be suppressed using the -nosoundcheck
command line option.

To suppress error message:

1.Right-click on the Phone Manager shortcut and select Properties.

2.Select the Shortcut tab.

3.The Target will be similar to: "C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe".

After the closing quotation mark, add -nosoundcheck. For example:
"C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe" -nosundcheck 

4.Click OK.

5.Test the shortcut.
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Screen Popping

Chapter 3.



Phone Manager Page 40
- Issue 05a (01 February 2010)IP Office

3. Screen Popping
Phone Manager Pro can be set to pop an external application whenever an incoming call arrives. In addition to starting an
external application, Phone Manager Pro also passes some basic call data to that external application. The data passed is:

· Calling Party
The number of the calling party, if available.

· Called Party
Usually the number of the Phone Manager Pro extension.

· Tag
Any name or other information associated with the call. Phone Manager and SoftConsole can be used to add a tag
to a call before it is made or transferred.

· Account Code
Any account code matched against the Caller ID of the call in the IP Office configuration directory.  

· Display Text
Similar to the text string shown on display phones by IP Office when calls ring.

 

Screen popping requires the selected application to be running with the appropriate database at the same time as Phone
Manager Pro. The screen pop action is based on calling number (ICLID) matching. 

For IP Office 5.0 and higher, screen popping is only supported with Outlook 2003/2007. 
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Screen Popping:  

3.1 Phone Manager Configuration
Phone Manager needs to be configured so that contact details can be shown. The screen pop options are only available
when the content management packages are installed and detected by Phone Manager. 

For IP Office 5.0 and higher, screen popping is only supported with Outlook 2003/2007. 

To configure Phone Manager:

1.Click  | Screen Pop or click View | Preferences | Screen Pop.

2.In Phone Number select whether Phone Manager should screen pop for Internal and/or External numbers.

3.In Phone Mode select whether Phone Manager should screen pop when calls are Ringing or only on Answering a
call. 

4.Select Pop Outlook. If the incoming number matches a number in one of your contacts, that contact will pop up.
MAPI must be installed on your PC for this facility to be available. For more information, contact your system
administrator. 

5.Click OK.

6.To save your changes, click OK.
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3.2 Microsoft Outlook Notes
Phone Manager disables Outlook related functions if a suitable version of Outlook 2000, 2003 or XP is not found during
installation. Outlook 2000 or higher must be installed to enable these functions. Outlook Express is not supported.

Phone Manager uses MAPI to perform a CLI match for pop outlook. If the user does not have a default profile or no
profile exist then this function will not work.

Phone Manager only screen pops against the user's personal mailbox contacts, mailbox contacts and public folder
contacts. Where duplicate entries exist that order is the order of preference. 

To enable screen pop using Microsoft Outlook Notes:

1.Click Contacts > Properties > Outlook Address Book > Show this folder as an email address book.

2.Click OK.
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Creating Custom Skins

Chapter 4.
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4. Creating Custom Skins
This section describes how to create and loada skin for use on the IP Office Phone Manager and SoftConsole applications.
However, it does not attempt to teach how to use the required Skin Development application. Nor does Avaya support
use of skins other than those installed by Avaya as part of the default application installation. 

The example shown is Phone Manager with a skin called 'Gradic' loaded.

 

To load a new skin in Phone Manager

1.Click View | Load Skin.

2.Browse to the folder containing the new skin and select the skin.ini file. Phone Manager skin files are located by
default in: C:\Program Files\Avaya\IP Office\Phone Manager\Skin\

3.Click OK.

 

If you want to create a skin then skin development software is required. In the example, the Business Skin Form from
Almediadev (SkinBuilder.exe) was used. Trial software and a number of samples are available from www.almdev.com.

The SkinBuilder.exe application must be used to create or edit a skin. This application allows you to manipulate your
skin visually and has a built-in tester to test your skin definition. 
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Creating Custom Skins:  

4.1 Phone Manager Skin Objects and Controls
To create a new skin, make a copy of the Avaya skin definition folder in the skin directory (C:\Program Files\Avaya\IP
Office\Phone Manager\Skin\) and rename. Make the necessary changes required by your design. Modify the bitmaps, the
skin objects and the skin controls.

There are a number of sections in the Avaya skin definition .ini file. The following table describes the various sections in
the .ini file:

Version Version information and comments.

Pictures  Bitmap files used by the skin definition.

FormInfo Bitmaps for the main window.

PopupWindow Bitmaps for any pop up windows (menu etc).

HintWindow Bitmaps for tool tip.

SkinObjects Windows elements pertaining to the main window; caption bar, menu bar, maximize,
minimize and close buttons.

The following SkinObjects need to be defined for the Phone Manager main window.

closebutton Bitmap for the close button in the main window.

maxbutton Bitmap for the maximize button in the main window.

systembutton Bitmap for the system menu button in the main window.

minbutton Bitmap for the minimize button in the main window.

mainmenubaritem Bitmap for each item in the menu bar.

caption Bitmap for the main window caption bar.

menuitem Bitmap for each item in the drop down menu.

menubarsystemmenubutto
n

Bitmap for the system menu button on the main menu bar.

menubarclosebutton Bitmap for close button on the main menu bar.

menubarmaxbutton Bitmap for maximize button on the main menu bar.

menubarminbutton Bitmap for the minimize button on the main menu bar.

The following SkinControls need to be defined in Phone Manager.

Tab Bitmaps for the tabs; In, Out, All, Missed, Messages, Speed dials, etc.

Panel Bitmaps for the panels used in various dialogs; Make Call, Directory, Config PBX, etc.

Toolbutton Bitmaps for buttons in the toolbar (except for the volume control, see the toolmenutrack
button).

Mainpanel Bitmap for the background of the main window.

Button Bitmaps for push buttons in the main window.

Controlbar Bitmap for the background of the toolbar area.

Toolpanel Bitmap for the background of each toolbar.

mainmenubar Bitmap for the background of the main menu bar.

Checkbox Bitmaps for check boxes.

Stdlabel Bitmaps for labels.

groupbox Bitmaps for group boxes.

edit Bitmaps for edit controls.

toolmenutrackbutton Bitmaps for the volume control buttons on the toolbar.

vscrollbar Bitmaps for the vertical scroll bar used in various places.

updown Bitmaps for the up/down button to scroll the tabs.

trackbar Bitmaps for the volume control slider.

Phone Manager uses a second .ini file called dialog.in1 to define the appearance of the dialogs. The following table
describes the various sections in the .ini file:

FormInfo Bitmaps for the dialog box.

Caption Bitmaps for the dialog box caption bar.

Close Bitmaps for the dialog box close button.

Button Bitmaps for push buttons in the dialog that resides inside a panel.
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4.2 SoftConsole Skin Objects and Controls
To create a new skin, make a copy of the Avaya skin definition folder in the skin directory (C:\Program Files\Avaya\IP
Office\Phone Manager\Skin\) and rename. Make the necessary changes required by your design, modify the bitmaps, the
skin objects and the skin controls.

There are a number of sections in the Avaya skin definition .ini file. The following table describes the various sections in
the .ini file:

Version Version information and comments.

Pictures  Bitmap files used by the skin definition.

FormInfo Bitmaps for the main window.

PopupWindow Bitmaps for any pop up windows (menu etc).

HintWindow Bitmaps for tool tip.

SkinObjects Windows elements pertaining to the main window; caption bar, menu bar, maximize, minimize
and close buttons.

The following SkinObjects need to be defined for SoftConsole.

caption Bitmap for the form's title bar.

closebutton Bitmaps for the Close button in the form's title bar.

minimizebutton Bitmaps for the Minimize button in the form's title bar.

maximizebutton Bitmaps for the Maximize button in the form's title bar.

mainmenubaritem Bitmaps for the menu items on the form's main menu.

sysmenubutton Bitmaps for the System Menu button in the form's title bar.

menuitem Bitmaps for the drop down menus of the form's main menu.

The following SkinControls need to be defined for SoftConsole.

panel Background bitmap for dialog boxes and for various panels on the main form.

button Bitmaps for standard button controls. 

toolpanel Background bitmap for the Directory and Held Calls toolbars on the main form.

toolbutton Bitmaps for button controls on the Directory and Held Calls toolbars on the main form.

bigtoolpanel Background bitmap for the main tool bar on the main form.

bigtoolbutton Bitmaps for button controls on the main tool bar of the main form.

resizebutton Bitmaps for list view column headings.

mainmenubar Background bitmap for the main menu bar on the main form.

statusbar Background bitmap for the status bar controls.

statuspanel Background bitmap for panels within a status bar control.

stdlabel Attributes of label controls.

listview Bitmap for list view controls.

hscrollbar Bitmaps for horizontal scroll bar controls.

vscrollbar Bitmaps for vertical scroll bar controls.

bothhscrollbar Bitmaps for displaying vertical and horizontal scroll bar controls simultaneously.

vsplitter Bitmap for vertical splitter controls on the main form.

hsplitter Bitmap for horizontal splitter controls on the main form.

tab Bitmaps for tab sheet controls.

hupdown Bitmaps for left/right arrow controls used for navigating through tab sheets when all of the tabs
cannot be displayed)

vupdown Bitmaps for up/down arrow controls used for navigating through tab sheets when all of the tabs
cannot be displayed)

bevel Bitmap for bevel controls.

checkbox Bitmaps for check box controls.

radiobox Bitmaps for radio controls.

groupbox Bitmaps for group box controls.
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Performance figures and data quoted in this document are typical, and must be
specifically confirmed in writing by Avaya before they become applicable to any
particular order or contract. The company reserves the right to make alterations
or amendments to the detailed specifications at its discretion. The publication of

information in this document does not imply freedom from patent or other
protective rights of Avaya or others.

Intellectual property related to this product (including trademarks) and registered
to Lucent Technologies have been transferred or licensed to Avaya.

All trademarks identified by the ® or ™ are registered trademarks or trademarks,
respectively, of Avaya Inc. All other trademarks are the property of their

respective owners.

This document contains proprietary information of Avaya and is not to be
disclosed or used except in accordance with applicable agreements.

 
Any comments or suggestions regarding this document should be sent to

"wgctechpubs@avaya.com".

© 2010 Avaya Inc. All rights reserved.
Avaya

Unit 1, Sterling Court
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Welwyn Garden City
Hertfordshire 

AL7 1LZ
England.

Tel: +44 (0) 1707 392200
Fax: +44 (0) 1707 376933

Web: http://marketingtools.avaya.com/knowledgebase
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